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BizInsight 5.0.35.1

Applying Product Updates

This document applies to the following ERP system(s):

AccountMate Microsoft Dynamics GP Sage 500
Acumatica Microsoft Dynamics SL Sage X3v5
Alere QAD EE Sage X3v6
CCH QAD SE SAP B1
Deltek Vision Ross Syspro
FiresStream Sage 300 Traverse

Summary

BizNet Software will release updates to BizInsight and BizContent packs.  These are two dif-
ferent products and updates to one may not necessitate updates to the other.

When updates are released, an announcement email is sent from the BizNet portal site.  Pay
attention to whether the updated release was for the BizInsight product or a BizContent pack
and follow the steps in this document for whichever product was updated. 

Following is a description of the two products to help you determine what you need to update:

BizInsight- This product is a generic run-time engine that is added into Excel. This means that
updates will be made on each client workstation, or a Terminal Services/Citrix Server if imple-
mented that way. It does not have any server components.

BizContent - This product provides the connectivity to your accounting system and provides the
functions and analysis sets that are used to retrieve data from the accounting system. Similar to
BizInsight, it consists of an add-in to Excel but also has server side elements that will need to be
updated when a new version is released. Review the system requirements for the content
pack to confirm your implemented BizInsight version is compatible.

BizInsight and BizContent are interdependent products. If you have one, you will have the other.

 Important Information 

l Be sure to plan the implementation of the update for a time when reporting needs are low
just in case issues are encountered during the update.



Table of Contents

Updating BizContent 1

Step 1: Run Content Installer 1

Step 2: Updating Client Workstations with new Content 18

Updating BizInsight Content on a Citrix/Terminal Services Server 19

Step 3: Re-Create Custom Objects 20

Retrieving Custom Properties 21

Updating BizInsight 29

Updating BizInsight in a Citrix/Terminal Services Environment 44

Appendices 65

Automatic Install 66

Deploy Data Set Content 78

Config Tool 82

Manually Deploying Content Reporting Services Reports 90

Manually Installing BizContent Add-ins 97

Server Configuration Changes for XMLFast 108

Resolving “.xll could not be found” errors 137

Assign rights in Reporting Services 149

BizInsight Column Based Security Overview 151

BizNet Software, Inc. i| Page

BizInsight 5.0.35.1 Applying Product Updates



BizInsight 5.0.35.1 Applying Product Updates: Updating BizContent

BizNet Software, Inc. 1| Page

Updating BizContent
Prior to running the content installer, confirm that the following system requirements are sat-
isfied. If any of the following are not satisfied, this installer tool cannot be used.

l The server operating system is one of the following:
o Windows Server 2003 R2 (SP2 or later)

o Windows Server 2008 (SP2 or later)

o Windows Server 2008 R2

o Windows Server 2012

l The user performing the installation has Administrator privileges

l Existing SQL Server installations that can be used are SQL Server 2008, SQL Server
2008 R2, SQL Server 2012 and SQL Server 2014. If the existing SQL Server installation is
not one of the supported versions, use the Content Installer to install a side-by-side SQL
Server 2008 R2 Express instance.

l The C:\ drive must have at least 5 GB of available space for the SQL Server installation
(if an existing SQL installation cannot be used)

l The server is NOT a domain controller.
In the event the server is a domain controller, a supported version of SQL Server and
Reporting Services must be installed manually before running the Content Installer.
Example installation steps can be found in the document titled "Installing SQL Server and
Reporting Services".

l If the Content Installer will not be used to install an Express edition of SQL Server and
Reporting Service, the server must have a SQL database engine installed.

l If using an existing SQL Server installation, the Windows log in of the user performing
the installation must have sysadmin rights to the SQL server installation.

Step 1: Run Content Installer

1. Go to a workstation with BizInsight installed, start Excel and click on the Application
Settings button on the BizInsight ribbon menu.  Make a note of the reporting services
URL currently being used and the reporting services folder name.  You will need these
two pieces of information for the content deployment.
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2. Before closing the Application Settings dialog, click on the Configure SQL button to see
if you are using SQL metadata databases. If this dialog is configured, you are using SQL
metadata databases.
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3. Make backups of the BizInsight metadata databases.

l If you are using SQL metadata databases, go to the server, open SQL Management
Studio and backup each of the databases (BizInsight and BizInsightDB).

l If you are not using SQL metadata databases, browse to the Configuration Path
directory and backup the current .biz files (BizInsight.biz and BizInsightDB.biz) by
moving them to a backup folder. Do not leave the biz files in the
Configuration Path during the Content Installer installation.

4. Go to the database server and download the updated content installer file.  All content
can be downloaded from the BizNet Software portal,
(http://biznet.flexnetoperations.com).   All files can be found under "Browse My
Software and Documentation".

5. Extract the contents of the download file on the server and double-click the file named
“Setup.exe”.

 IMPORTANT  The content installer must be run on the server where the SQL database

http://biznet.flexnetoperations.com/
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resides or where a SQL database engine is installed. It is not designed to be run from a
client workstation.

6. The Welcome dialog will open.  Click Next.

7. Review the End User License Agreement and if you agree to the terms, check the I
accept the terms in the License Agreement checkbox and click Next.
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8. Click on the desired Setup Type button.

Custom setup type options that are available:
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9. Click Install.

10. Click Yes to any User Account Control messages.

11. When the installer completes, an icon will exist on the desktop if you did not disable the
creation of shortcuts.

12. Double-click the shortcut on the desktop to launch the content installer.  If you chose a
Custom installation and disabled the creation of shortcuts, you must browse to the
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directory to which the content was installed and double-click the BizNet Content
Installer.exe.

13. The content installer will inspect the server and determine what elements already exist
on the server and indicate their presence.
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IMPORTANT  If this is the first time you have installed anything with the content
installer, nothing will be detected. In this case, see "Automatic Install" on page 66 of the
Appendix for further instructions.

14. If there is a Run Scripts button showing, check the Readme tab of the Content
Specifications workbook to see if there was an update to the scripts (unlikely). If the
Readme does not indicate a change,you can skip the Run Scripts button.
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The Content Specifications workbook can be found with the content installer setup.exe
file.

15. Click the Deploy DataSet Content button.
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16. The content installer will open the content deployment dialog.  Most paths will not need
to be changed.  But you must check the following to make sure they are correct:

a. Verify that the Default Reporting Services Server field contains
the correct URL based on what was noted from Step 1 above. If
this field is blank or incorrect, type in the correct Reporting
Services URL.
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b.  IMPORTANT  Make sure the folder name is the folder name
currently being used (noted in Step 1 above).  If the folder is not
the same, change the name to match the folder name currently
being used.
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c. Adjust the Server Name field if your accounting system database
is on another server.

d. Adjust the Database Name field to point to your accounting
system database.  If your accounting software uses a system or
control database, provide the name of that database rather than a
company database name.



BizInsight 5.0.35.1 Applying Product Updates: Updating BizContent

BizNet Software, Inc. 13| Page

e. Select the desired authentication method – Windows
authentication or Prompt for Credentials.

f. Make sure the Overwrite DataSources checkbox is unchecked.

g. Click Deploy Content to continue.
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The Content Deployed Successfully dialog will open and display
the Web Service and the Report Manager URLs.  Click Close.

If you encounter an error deploying the DataSet Content, contact
BizNet Software Support for assistance.

17. Click the Deploy metadata Content button.
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18. The Local Content path will already be completed with the path used for previous
content installations.  If this path is still valid, click OK.  Otherwise, Browse to the folder
to use for the Configuration Path and then click OK.

The following error may occur if the SQL Server instance already has metadata
databases (BizInsight and BizInsightDB databases) and the existing metadata databases
were not created with a Content Installer.

If the above message occurs, you must recreate all custom Navigation Pane nodes and
refresh any Optimize Cache and Account Definition workbooks after the installation
completes. Subsequent installations should not require this step. There is more
information regarding recreating your custom objects in the section titled "Re-Create
Custom Objects".
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19. Click the Deploy Function Content button.

20. The Local Content path will already be completed with the path used for previous
content installations.  If this path is still valid, click OK.  Otherwise, Browse to the folder
to use for the Configuration Path and then click OK.
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21. Once all elements have green check marks, click Exit.

Repeat these steps for any other BizContent pack updates.
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Step 2: Updating Client Workstations with new Content

Once all BizContent updates have been applied to the server, each client workstation install-
ation needs to be updated with the new content add-in files. 

If BizInsight is being used in a Citrix/Terminal Services environment, see "Updating BizInsight
Content on a Citrix/Terminal Services Server" on the next page.

If BizInsight is installed on individual workstations, instruct all BizInsight users to click on the
Scan for Content button on the BizInsight ribbon in Excel to update their workstations with the
new content.

If the users report that the Scan for Content button is missing, they may not have the most cur-
rent BizInsight version. The Scan for Content button was added in version .  BizNet Software
recommends downloading and installing the latest BizInsight version but if you must use an
older version, see "Manually Installing BizContent Add-ins" on page 97.

If your users report an error similar to the following when opening Excel again, see "Resolving
“.xll could not be found” errors" on page 137 for steps to resolve.
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Updating BizInsight Content on a Citrix/Terminal
Services Server

1. Copy all new BizContent add-in files (.dll, .dna and .xll) from the Configuration Path to
the local BizInsight directory. You will be replacing the ones that should already be there
with the new versions. If you do not know the location of the Configuration Path, launch
the Content Installer on the server and click on the Relevant Information link in the
upper right of the dialog.

 IMPORTANT  If you are not prompted to replace existing files when you copy in the
new files, that means one or more of the add-in file names have changed (rare but does
happen). In that circumstance, you must do the following additional steps:

i. Open the file named "Excelxxxx_register_OnDemand.reg" and change the
OPENn entry for the add-in that had its name changed so that the name of the
add-in matches the new filename. Save your changes.

ii. Have each BizInsight user execute the "Register BizInsight for Excel xxxx
OnDemand.bat" to register the content for their login.
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Step 3: Re-Create Custom Objects

l Custom Navigation Pane nodes. These items are most commonly templates. For steps on
how to re-add these custom nodes, refer to the section titled "Templates" in the User
Guide. Ex:

 IMPORTANT  If BizInsight 5.0.35.1 or higher is installed, the Properties menu can be used to
assist in the retrieval of the following custom settings so they can be added back to the new
SQL MetaData files. See "Retrieving Custom Properties" on the next page for instructions.

NOTE  Custom Navigation Pane nodes cannot be retrieved using the Properties menu.

l Any Account Definitions. ou should have a central workbook that contains your account
definitions. Just open that workbook and refresh it to recreate your account definitions.
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l Custom pivot layouts. Custom pivot layouts are created using the Save Pivot Layout option
on the BizInsight right-click menu when a BizInsight created pivot layout is right-clicked.

Retrieving Custom Properties
BizInsight 5.0.35.1 provides a Properties menu with an analysis set that can be used to retrieve
all custom settings such as Optimize Cache definitions, Account Definitions and custom Pivot
Layouts. To recover custom settings, do the following:

1. Make sure the .biz files containing the customizations reside in the Configuration Path to
which BizInsight is pointed.

2. Open BizInsight and click on the Application Settings button on the BizInsight ribbon.
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3. If the Use settings fromConfiguration Path checkbox is checked, uncheck it.

4. Click on the Configure SQL button. If the dialog is filled in, take a screenshot of the
dialog so that it can be reinstated to original values. Then uncheck the Use SQL Server
for MetaData checkbox.

5. On the Application Settings dialog, make sure the Configuration Path is pointed to the
directory that contains the .biz files. The click OK to close. You will be prompted to
restart Excel.

6. Re-open Excel.
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7. Click on the Properties button on the Navigation Pane to display the Properties menu.

8. Expand the AnalysisSets node then drag and drop the User-Defined Properties analysis
set.
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9. Right-click on the analysis set and choose Data Range Properties.
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10. Uncheck the Save query definition checkbox to make the analysis set static.

11. Click OK to the warning message that opens.

12. Click on the Offline button to take BizInsight offline.
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13. From the Functions node of the Propertiesmenu, drag and drop a SetAcctDef function
and drop it in a column to the left of the analysis set. Add a column if one is not already
there.

14. Click on the Excel fx button to open the Function Arguments dialog for the SetAcctDef
function and pass in cell references for each of the parameters. The column headers for
the analysis set match up with the function parameter names.
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15. Copy the SetAcctDef function down for all rows of the analysis set.

16. Save the workbook.

17. Go back to the Application Settings and Configure SQL dialogs and restore the settings
to the original values.

18. Close and reopen Excel.

19. Load BizInsight.
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20. Open the workbook with the SetAcctDef formulas, right-click and choose BizNet
Refresh. This will create the properties in the new SQL MetaData database.
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Updating BizInsight
BizInsight updates are always installed on the client workstations. If BizInsight is implemented
on a Terminal Services/Citrix server, see "Updating BizInsight in a Citrix/Terminal Services
Environment" on page 44.

Before applying a BizInsight update, be sure to read the Release Notes provided with the
release to understand the changes made to the product.

1. As of BizInsight version 5.0.34, BizInsight users must be given Content Manager rights in
Reporting Services security.  This is done on the Reporting Services server from the
Report Manager site.  See "Assign rights in Reporting Services" on page 149 for
information on where to make this change.

2. If you are updating from a BizInsight version older than 5.0.34, there is a new feature
called XMLFast that is enabled by default.For this feature to work properly, you must
confirm that the following requirements are satisfied on the server:

l TCP/IP remote connection must be enabled for SQL Server

l The SQL Browser service is started

l Server firewall exceptions must be added for TCP Port 1433, UDP Port 1434 and a
program exception for sqlservr.exe

l The Reporting Services data source is not configured with stored user credentials.

For instructions on implementing the above configuration changes see "Server
Configuration Changes for XMLFast" on page 108.

If you're not sure what BizInsight version you're currently using, go to a client
workstation and open Excel. Click on the About button on the BizInsight ribbon.
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3. Open Excel on a workstation where BizInsight is installed. Click on the Application
Settings button on the BizInsight ribbon. If the Application Settings dialog is grayed out
and the Use settings from Configuration Path option is checked, skip to the next step.

4. If the Use Settings from Configuration Path is not checked, copy the path provided for
the Configuration Path and check that directory to see if there is an app.config file. If an
app.config is present, skip to the next step.
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a. If an app.config is not present, take a screenshot of the Application Settings
dialog. You will need to confirm these paths and possibly re-enter them when
configuring the new version of BizInsight.
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Click on the Configure SQL button and, if configured, take a screenshot of that
dialog.
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5. Download the new BizInsight version from the BizNet Software portal.  The portal can be
accessed by going to http://biznet.flexnetoperations.com.

http://biznet.flexnetoperations.com/
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6.   IMPORTANT  Uninstall the previous BizInsight installation from Control Panel >
Programs and Features.

NOTE  If BizInsight is not shown, this means that the product was installed while logged
in as a different user account.  If you do not know what account that was, install the new
version then uninstall and reinstall it to clear the old BizInsight installation.

7. Locate the BizInsight product installation files that you downloaded from the portal site
and extract the contents.

8. Extract the .zip contents to any directory that is accessible from the client workstation.

9. Double-click the Setup.exe for the Excel version that is installed on the client
workstation.

10. The installation will check to see if Microsoft .Net Framework 4.0 is installed.  If not
installed, the following dialog will display.  Click Accept.
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11. The installation will then check to see if the Microsoft Office Primary Interop assemblies
for the installed Excel version are installed as well as a specific Microsoft Update that is
necessary for proper Excel add-in functionality.  If not found, the following dialog will
display.  Click Install.
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12. The splash dialog will open.  Click Next to continue.
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13. The Welcome dialog will open.  Click Next to continue.

14. The License Agreement dialog will open.  Read through the agreement and if you agree
with the terms, click the I agree radio button and then click Next.
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15. Accept the default installation directory or browse to a location of your choice. Click
Next.

16. Click Next at the Confirm Installation dialog.
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17. When installing BizInsight versions 5.0.35.1 or higher, the Enter your Configuration
Path dialog will open. If you have an app.config file produced by a Content Installer in
your Configuration Path, leave the default option. Click OK.

If you do not have a Content Installer created app.config file, choose the User Managed
radio button to proceed. You will need to supply the key paths when configuring
BizInsight for the user. When you click OK, the Import Settings Skipped dialog will open.
Click OK.
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18. If the Centrally Managed option was selected, click the Browse button and browse to the
Configuration Path shared directory.

Click Import Settings.

19. Once the installation completes, click Close.
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20. Start Excel.

21. You should see BizInsight load and the Navigation Pane display on the left side in Excel.

22. Close and reopen Excel.

23. When Excel reopens, click on the BizInsight tab on the ribbon.   IMPORTANT  If the
Navigation Pane opens automatically, close and reopen Excel again. 

24. If you are not using Centrally Managed user settings, click on the Application Settings
button on the BizInsight tab and confirm that all fields are populated with the correct
information for your implementation. Correct the settings if necessary.
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If the Configure SQL dialog was populated before, click on the Configure SQL button to
check that dialog. Correct the settings if necessary.

Click OK to close.
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25. On the BizInsight ribbon (Excel 2007 and Excel 2010) or the BizInsight toolbar (Excel
2003), click on the Scan for Content button.

 IMPORTANT   If the BizInsight ribbon (or toolbar) is missing, close Excel and click on
Start > All Programs > BizNet Software > Register BizInsight for Excel xxxx On
Demand and check in Excel again.

26. You will receive the following information message.  Click No. Excel will close.

27. After Scan for Content completes, click OK and reopen Excel.

28. Load BizInsight then refresh an existing report to confirm that the new installation
functions correctly.
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Updating BizInsight in a Citrix/Terminal Services Environment

There are some differences to the implementation of a BizInsight update for a Citrix/Terminal
Services environment than for an individual workstation.

1. As of BizInsight version 5.0.34, BizInsight users must be given Content Manager rights in
Reporting Services security.  This is done on the Reporting Services server from the
Report Manager site.  See "Assign rights in Reporting Services" on page 149 for
information on where to make this change.

2. If you are updating from a BizInsight version older than 5.0.34, there is a new feature
called XMLFast that is enabled by default.For this feature to work properly, you must
confirm that the following requirements are satisfied on the server:

l TCP/IP remote connection must be enabled for SQL Server

l The SQL Browser service is started

l Server firewall exceptions must be added for TCP Port 1433, UDP Port 1434 and a
program exception for sqlservr.exe

l The Reporting Services data source is not configured with stored user credentials.

For instructions on implementing the above configuration changes see "Server
Configuration Changes for XMLFast" on page 108.

If you're not sure what BizInsight version you're currently using, go to a client
workstation and open Excel. Click on the About button on the BizInsight ribbon.
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3. Open Excel on a workstation where BizInsight is installed. Click on the Application
Settings button on the BizInsight ribbon. If the Application Settings dialog is grayed out
and the Use settings from Configuration Path option is checked, skip to the next step.

4. If the Use Settings from Configuration Path is not checked, copy the path provided for
the Configuration Path and check that directory to see if there is an app.config file. If an
app.config is present, skip to the next step.



BizInsight 5.0.35.1 Applying Product Updates: Updating BizInsight

BizNet Software, Inc. 46| Page

a. If an app.config is not present, take a screenshot of the Application Settings
dialog. You will need to confirm these paths and possibly re-enter them when
configuring the new version of BizInsight.

Click on the Configure SQL button and, if configured, take a screenshot of that
dialog.
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5.  IMPORTANT  Browse to the reg5 subdirectory of the BizInsight installation location and
backup the following two files:

l "Excelxxxx_register_OnDemand.reg". 

l Register BizInsight for Excel xxxx OnDemand.bat".

See the Citrix_Terminal Services Deployment document for information about the role
of these files in a Citrix/Terminal services implementation.

6.   IMPORTANT  Uninstall the previous BizInsight installation from Control Panel >
Programs and Features.

NOTE  If BizInsight is not shown, this means that the product was installed while logged
in as a different user account.  If you do not know what account that was, install the new
version then uninstall and reinstall it to clear the old BizInsight installation.

7. Locate the BizInsight product installation files that you downloaded from the portal site
and extract the contents.

8. Extract the .zip contents to any directory that is accessible from the client workstation.
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9. Double-click the Setup.exe for the Excel version that is installed on the client
workstation.

10. The installation will check to see if Microsoft .Net Framework 4.0 is installed.  If not
installed, the following dialog will display.  Click Accept.

11. The installation will then check to see if the Microsoft Office Primary Interop assemblies
for the installed Excel version are installed as well as a specific Microsoft Update that is
necessary for proper Excel add-in functionality.  If not found, the following dialog will
display.  Click Install.
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12. The splash dialog will open.  Click Next to continue.
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13. The Welcome dialog will open.  Click Next to continue.

14. The License Agreement dialog will open.  Read through the agreement and if you agree
with the terms, click the I agree radio button and then click Next.
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15. Accept the default installation directory or browse to a location of your choice. Click
Next.

16. Click Next at the Confirm Installation dialog.
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17. When installing BizInsight versions 5.0.35.1 or higher, the Enter your Configuration
Path dialog will open. If you have an app.config file produced by a Content Installer in
your Configuration Path, leave the default option. Click OK.

If you do not have a Content Installer created app.config file, choose the User Managed
radio button to proceed. You will need to supply the key paths when configuring
BizInsight for the user. When you click OK, the Import Settings Skipped dialog will open.
Click OK.
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18. If the Centrally Managed option was selected, click the Browse button and browse to the
Configuration Path shared directory.

Click Import Settings.

19. Once the installation completes, click Close.
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20. Browse to the reg5 subdirectory of the BizInsight installation location and reinstate the
backup copies of the files named "Excelxxxx_register_OnDemand.reg" and "Register
BizInsight for Excel xxxx OnDemand.bat".

21. If you are Centrally Managing your user settings, skip to the next step, see "Start Excel."
on page 62.

If you are not Centrally Managing your user settings, you must perform the following
steps to configure the app.config file with the necessary path information for your
environment. This step is essential for ensuring that these paths are defined for each
user automatically.

a. If you have not already downloaded the BizInsight Tools.zip, log into the BizNet
Software portal (http://biznet.flexnetoperations.com) to download the file. You
will find the file with the BizInsight download file. Extract the contents.

b. Browse to the AppConfigTool folder and double-click the file named
AppConfigTool.exe.

c. Click on the Browse button.

http://biznet.flexnetoperations.com/
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d. Browse to the bin5 subdirectory of the BizInsight installation directory and select
the app.config file. Click Open.

e. Locate the MetaDatabaseType entry and change the value to "SQL". This
change "checks" the Use SQL Server for MetaData checkbox on the Configure
SQL dialog.
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f. OPTIONAL If the users are using SQL authentication to connect to the
SQL MetaData databases (BizInsight and BizInsightDB), locate the
MetaDatabaseTypeAuth entry and change it to SQL. This change "checks" the
Use SQL Authentication checkbox on the Configure SQL dialog.
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g. The next steps will walk you through setting the connection strings for the two
SQL MetaData databases.

i. Locate the BizInsightMenuConnectionString entry and paste one of the
following text samples for the value depending on which method of
authentication will be used to connect to the SQL MetaData databases.

Windows Authentication
Provider=SQLOLEDB;Data source=servername;Initial
Catalog=BizInsight;Integrated Security=SSPI;

SQL Authentication
Provider=SQLOLEDB;Data source=servername;Initial
Catalog=BizInsight;user id=
UserID;password=PASSWORD;

ii. Change the placeholder entries from these samples with the appropriate
server name and, if using SQL authentication, a valid SQL user id and
password.
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iii. Copy your edited connection string, locate the
BizInsightDataDBConnectionString entry and paste your copied
connection string for its value.
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iv. Edit the copied connection string to change the Initial Catalog value to
BizInsightDB.

h. Locate the DefaultSSRSLocation entry and type in the Reporting Server URL
shown in the screenshot taken of the Application Settings dialog at the start of
this process. This entry provides the value for the Default Reporting Services
Server field on the Application Settings dialog.
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i. Locate the DefaultSSRSPath entry and provide the Report Folder name from the
Application Settings screenshot. This entry provides the value for the Default
Reporting Services Folder Name field on the Application Settings dialog.

j. Locate the BizInsightMenuDB, BizInsightDataDB, BizInsightDataDBHistory and
the ConfigPathV4 entries. Update each one to replace C:\BizInsight with the
UNC path to the Config Path directory shown in the Relevant Info dialog. These
entries all relate to the Configuration Path field of the Application Settings
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dialog.

k. Locate the AdminPath entry and update its value to the Admin Path directory
shown in the Relevant Info dialog. This entry sets the value for the
Administration Path field of the Application Settings dialog.
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l. Click the Save Settings button and click Done to close the AppConfigTool.

m. Copy this configured app.config file to the Configuration Path directory for future
use as a settings import file for any future BizInsight installations.

22. Start Excel.

23. You should see BizInsight load and the Navigation Pane display on the left side in Excel.

24. Close and reopen Excel.

25. When Excel reopens, click on the BizInsight tab on the ribbon.   IMPORTANT  If the
Navigation Pane opens automatically, close and reopen Excel again. 
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26. Click on the Application Settings button on the BizInsight tab and confirm that all fields
are populated with the correct information for your implementation.

27. If the Configure SQL dialog was populated before, click on the Configure SQL button to
check that dialog. If this dialog is not correctly populated, go back to the AppConfigTool
and make the corrections via the tool, not the Configure SQL dialog.
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IMPORTANT Close the Configure SQL and Application Settings dialogs using the X in
the upper right corner of the dialog. This will prevent a user.config file from being
created for the currently logged in account that will override the app.config file settings.

28. Close Excel.

29. Browse to the reg5 subdirectory of the BizInsight installation directory and double-click
the file named "Register BizInsight for Excel xxxx OnDemand.bat" to register the
content. This should register the BizContent add-ins for your login id so that the
installation can be tested and verified to be functional.

30. Restart Excel and load BizInsight by clicking on the BizInsight Explorer button on the
BizInsight ribbon.

31. Open an existing report, right-click and choose BizNet Refresh to test that the new
installation functions correctly.

32. If the report refreshes correctly, have each BizInsight user execute the "Register
BizInsight for Excel xxxx OnDemand.bat" to register the BizInsight version for their
login.
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Automatic Install

This section describes installing using the Automatic Install button.

1. Clicking on Automatic Install will open a prompt to designate your shared directory
location.  Click on the Browse button and browse to the folder that contains the
configuration files (.dll, dna and .xll files, Templates subdirectory and .biz files). 

Click OK.

2. You may be asked to enable the local Administrator account. Click OK, Thanks, even if
you know that the Administrator account is enabled.

3. If the Content Installer detects existing instances of SQL Server Reporting Services
installed on the local server machine, the following dialog will display giving you the
option to use the existing installation or to install a side by side installation. 
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Option Description

Click here to start a side
by side installation of
SQL Server 2008 R2
Express

The side-by-side option is the recommended option to ensure
that all configuration changes needed for BizInsight purposes do
not interfere with other applications that may be using SQL or
Reporting Services. It is especially recommended when your
existing SQL Server is version 2005.  BizNet Software Support
will not assist with implementing Reporting Services 2005. 

Click here to use a
currently installed SQL
Server that you have
checked above

Use this button to specify that the installer use a detected
existing instance. Be sure to check the checkbox next to any
detected instance before using this button.
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Option Description

Click here to override and
enter your Sql Server
information

Use this button If you need to specify a different port or want to
use HTTPS for secure communications or your existing
installation is not detected.

When this button is clicked, a warning will display to emphasize
the requirement that the content installer must be run on a
server with a SQL database engine installed. Click OK to clear the
message.

In the Connection String for SQL Server field, enter a valid
connection string for the SQL Server instance to which the
Content Installer should install the SQL MetaData databases.
Use theWindows Authentication Example or the SQL Server
Authentication Example buttons to populate the connection
string with sample syntax. Be sure to change the values to
values valid for your environment.

In theWeb URL for Report Server field, enter theweb service
URL for the Reporting Services site to which Content Installer
should deploy the content RDLs.

If no Reporting Services Server is detected, the process automatically installs SQL Server
2008 R2 Express with Advanced Services and uses “BIZNET” as the default Report Server
instance name.
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 IMPORTANT  IF an existing reporting services installation that you want to use is not
detected by the installer or you are not able to use the Override option, contact BizNet
Software Support for assistance.

If you get the following error after selecting the side by side installation, verify that you
have internet access.

If the side-by-side installation fails, contact BizNet Software Support for assistance.

4. The Content Deployment dialog will open next. Most values will be automatically
completed for you in this dialog.

a. Verify that the Default Reporting Services Server field contains the correct
URL based on what was noted from Step 1 above. If this field is blank or
incorrect, type in the correct Reporting Services URL.
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b.  IMPORTANT  Make sure the folder name is the folder name currently being
used (noted in Step 1 above).  If the folder is not the same, change the name
to match the folder name currently being used.
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c. Adjust the Server Name field if your accounting system database is on
another server.

d. Adjust the Database Name field to point to your accounting system database. 
If your accounting software uses a system or control database, provide the
name of that database rather than a company database name.
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e. Select the desired authentication method – Windows authentication or
Prompt for Credentials.

f. Make sure the Overwrite DataSources checkbox is unchecked.

g. Click Deploy Content to continue.



BizInsight 5.0.35.1 Applying Product Updates: Appendices

BizNet Software, Inc. 73| Page

The Content Deployed Successfully dialog will open and display the Web
Service and the Report Manager URLs.  Click Close.

If you encounter an error deploying the DataSet Content, contact BizNet
Software Support for assistance.

5. The content installer will continue automatically installing elements.  You will see the
content installer window update with green checks as the installer completes the
elements.
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The following error may occur if the SQL Server instance already has SQL metadata
databases (BizInsight and BizInsightDB databases) and the existing metadata databases
were not created with a Content Installer.

If the above message occurs, you must recreate all custom Navigation Pane nodes and
refresh any Optimize Cache and Account Definition workbooks after the installation
completes. Subsequent installations should not require this step.
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6. The License Administration Tool will open. Unless you need to add new BizInsight users,
click Exit.

7. After automatic install is complete, relevant information is displayed.  Click Close.
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8. The content installer will indicate that all elements have been successfully installed. 
Click Exit.
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Deploy Data Set Content
This button can be used to deploy the reporting services reports to the Report Server. 

Most values will be automatically completed for you in this dialog but the following items
should specifically be checked and confirmed to contain correct information:

a. Verify that the Default Reporting Services Server field contains the correct URL
based on what was noted from Step 1 above. If this field is blank or incorrect, type in
the correct Reporting Services URL.

b.  IMPORTANT  Make sure the folder name is the folder name currently being used
(noted in Step 1 above).  If the folder is not the same, change the name to match the
folder name currently being used.
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c. Adjust the Server Name field if your accounting system database is on another
server.

d. Adjust the Database Name field to point to your accounting system database.  If
your accounting software uses a system or control database, provide the name of
that database rather than a company database name.
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e. Select the desired authentication method – Windows authentication or Prompt for
Credentials.
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f. Make sure the Overwrite DataSources checkbox is unchecked.

g. Click Deploy Content to continue.

The Content Deployed Successfully dialog will open and display the Web Service
and the Report Manager URLs.  Click Close.

If you encounter an error deploying the DataSet Content, contact BizNet Software
Support for assistance.
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Config Tool
Use this tool to configure default values for the BizInsight users. These settings will be stored in
an app.config file that can be copied to each user's workstation after BizInsight is installed.
Users will still be able to adjust these options to their own preferences. When users adjust these
settings, their adjustments will be stored in a user.config file in their profile and that file will be
read first before the app.config file.

General Tab

The values shown in the General Tab should be automatically filled in by the Content Installer
with the pertinent paths for the BizInsight implementation. If user profiles are remapped to net-
work locations (instead of their local C:\ drive), use the Content Path Override section to spe-
cify an alternate default local folder to which BizInsight Scan for Content can copy the
BizContent add-in files.
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User Experience Tab

Use this tab to manage various user experience settings for all BizInsight users. The current set-
tings are the recommended default values but can be adjusted as desired. A brief explanation
of each option is provided below.



BizInsight 5.0.35.1 Applying Product Updates: Appendices

BizNet Software, Inc. 84| Page

Option Description

Show Large

Filters

When a user drills down on a function, the parameters used for the func-
tion are stored in a property of the analysis set. The field in which those
values are stored is limited to 255 characters. When the total length of
the string representation of the parameters exceeds 255 characters, the
string will be truncated to 255 characters. Use this option to store para-
meters strings that exceed 255 characters in a cell above the analysis set.
You will want to do this if you intend to keep the analysis set list in the
workbook and have it refresh on subsequent workbook refreshes. The
user would need to change the analysis set properties to point to the cell
containing the parameters. See section 3.8.1 Passing Parameters to Ana-
lysis Set Lists of the User Guide for instructions on how to point the ana-
lysis set to that cell.
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Option Description

Refresh Timer When the BizInsight right-click option to refresh a report is used, a dialog
can display at the end of the refresh with information on how long the
report took to refresh and how many functions were refreshed. Use this
option to turn that dialog on or off.

Caching Window BizInsight can be configured to display a caching window for each data
cache being built. .This feature is turned off by default.

 IMPORTANT  For Excel 2013 users, this option cannot be enabled if the
Formula Editor Pop-up option is enabled.
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Option Description

Formula Editor
Popup

This option can be used to control whether the Function Arguments dialog
automatically opens for a user when a function is dragged and dropped
from the BizInsight Navigation Pane into a worksheet.

 IMPORTANT  For Excel 2013 users, this option cannot be enabled if the
Caching Window option is enabled.

Expression Editor
Render Mode

The Expression Editor is a BizInsight feature that helps users construct
complex expressions for their functions parameters. This option exists to
allow customers to switch to hardware graphics rendering to address
usability issues with the Expression Editor dialog that may be caused by
the client workstation's video drivers.

Expression Editor
Start Up Page

Use this option to control whether the Expression Editor will start with the
Basic dialog or the Advanced dialog. BizNet Software recommends that
this setting be left at the default, Basic mode, for all users.
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Performance Tab

Option Description

XMLFast XMLFast is a feature that was added to BizInsight to improve data
retrieval performance. Data is retreived directly from the database
server using TCP/IP when this option is enabled. When this option is
turned off, the data retrieval is performed by Reporting Services and is
generally much slower. BizNet Software recommends leaving XML Fast
enabled.

Query Timeout When large data volumes are being retrieved, use this option to
increase the default timeout setting. The most common occurrence of a
timeout is during a drill down to transaction detail. If your company has
a large chart of accounts and significant transaction volume each
month, it is advised to increase this timeout setting.

Calculation Settings The Calculation Settings options allow you to control the scope of Excel's
recalculation of a workbook. Changing these options may result in
slower performance but may resolve situations when objects (functions
or Excel pivot tables) are not refreshed when a BizNet Refresh is per-
formed. BizNet Software recommends leaving this unchanged and
adjusting on an individual basis when necessary.
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Security Tab

Use this tab to specify what method of authentication will be used to for data retrieval and for
connection to the BizInsight MetaData databases (BizInsight and BizInsightDB SQL databases).

Option Description

SQL Authentication Prompt If the BizInsight users will be using SQL credentials to con-
nect to the accounting system database, choose the top
option. When BizInsight first attempts to retrieve data for
an Excel session, the user will be prompted to provide
their SQL credentials and those credentials will be used
for all subsequent data retrieval calls as long as that Excel
session stays open.

The Ask for your data server credentials every time
option should be used when Windows authentication will
be used for all data retrieval calls made to the accounting
system database.
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Option Description

Meta Database Type Authentic-
ation

Use this section to specify whether Windows authen-
tication or SQL credentials will be used to retrieve data
from the BizInsight MetaData databases. This is a com-
pletely different data connection than is used for retriev-
ing data from the accounting system database. If the SQL
option is selected, a SQL login id and password must be
provided in the Application Settings dialog after BizInsight
is installed on the client workstation.  WARNING 
SQL credentials will be stored in clear text in the resulting
configuration file.

Regardless of whether you made changes, click on the Configure Now button to create an app.-
config file that can be copied to each client workstation. Otherwise click on Exit to close the con-
figuration tool without creating an app.config file.
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Manually Deploying Content Reporting Services Reports

If the content installer does not detect your existing reporting services installation, it may be
necessary to manually deploy the reporting services reports. 

1. Run the content installer setup.exe to lay down the content files.

2. On the server where Reporting Services is installed (you’ll have to make sure that it
is installed and configured), open SQL Server Business Intelligence Development
Studio.

or Microsoft SQL Server 2012 > SQL Server Data Tools

Note  The SQL Server Data Tools for BI ("SSDT BI") is a separate download for
SQL Server 2014.
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 IMPORTANT  If your server operating system is Windows Server 2008 or higher and
User Account Control is enabled, Ctrl+Shift+Right-click on SQL Server Business
Intelligence Development Studio (or SQL Server Data Tools) and choose “Run as
administrator”.

3. Click on File > Open > Project/Solution
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4. Browse to the directory to which the content was installed, locate the Reporting
Services folder and select the .sln file. If one does not exist, select the .rptproj file.

5. Right-click on the shared data source and choose Open.
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6. Click on Edit.

7. Enter the accounting system database server name (and instance name if
applicable) in the Server name field.  Select the accounting system database from
the database drop down list. If your accounting system uses a system or control
database, select that database instead of a specific company database.  Once
configured, click OK.
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8. In the Solution Explorer, right-click on the top level and choose Properties.

9. Fill in the TargetReportFolder field with your preferred default folder name and
complete the Target Server URL field with the reporting services web service url. 
Click OK.
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10. Right-click on the top level in the Solution Explorer and choose Deploy.

11. Once the RDLs are deployed, double-click on the content installer icon on the
desktop.

12. Run the Deploy MetaDataContent and Deploy Function Content options in the
Manual Install Steps section to complete the content pack installation.
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Manually Installing BizContent Add-ins

If you are using a BizInsight version that is older than , you will need to register the BizContent
add-ins manually in Excel. BizNet Software recommends upgrading to the latest BizInsight ver-
sion but if that is not possible, perform the following steps:

1. Browse to the BizInsight shared directory and copy the content add-in files (.dll, .xll and
.dna) to the directory to which you installed the BizInsight client.  If you are using
separate config and admin folders, the client add-in files will be in the config folder.

The remaining steps vary based on the Office version installed:

Office 2010/2013 steps
Excel 2007 steps
Excel 2003 steps

Excel 2010/2013

1. Click on File > Options.
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7. Click on Add-ins in the left pane and then click on Go at the bottom on the right
pane.
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2. In the Add-ins dialog, click on the Browse button.

3. Browse to the directory to which you installed BizInsight and select the .xll file in
that directory.  Then click OK.

The Add-ins dialog should now look like the following:
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4. Click OK.
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Excel 2007

1. Click on the Office button and then click on the Excel Options button.
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2. Click on Add-ins in the left pane and then click on Go at the bottom on the right
pane.
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3. In the Add-ins dialog, click on the Browse button.

4. Browse to the directory to which you installed BizInsight and select the .xll file in
that directory.  Then click OK.

The Add-ins dialog should now look like the following:
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5. Click OK.
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Excel 2003

1. Click on Tools > Add-Ins
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2. In the Add-ins dialog, click on the Browse button.

3. Browse to the directory to which you installed BizInsight and select the .xll file in
that directory.  Then click OK.

The Add-ins dialog should now look like the following:
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4. Click OK.



BizInsight 5.0.35.1 Applying Product Updates: Appendices

BizNet Software, Inc. 108| Page

Server Configuration Changes for XMLFast

XMLFast requires the server to be configured a certain way. If you are currently using XMLFast,
you do not need to check these items. The following elements may already be configured on
the server but they should be checked and confirmed to be configured as they are needed for
XMLFast to function properly.

1. Check TCP/IP and SQL Browser, see "Enable TCP/IP" on the next page.

2. Add Windows Firewall Exceptions, see "Add Windows Firewall Exceptions" on page 119.

3. Verify SSRS Data Source Authentication, see "Verify Reporting Services Data Source" on
page 135.
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Enable TCP/IP

To enable TCP/IP, the steps vary depending on your SQL Server version.  The steps for SQL
Server 2005 are as follows.  For SQL Server 2008 or higher, see "SQL Server 2008" on page 114.

SQLServer 2005

1. Click on Start > All Programs > Microsoft SQL Server 2005 > Configuration Tools >
SQL Server Surface Area Configuration.
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2. Click on Surface Area Configuration for Services and Connections.
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3. In the left pane, click on SQL Server Browser. When the right pane has refreshed with
the options for the SQL Server Browser, make sure that Startup Type is set to
"Automatic" and click on Start if the service is not started.
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4. Under Database Engine, click on Remote Connections. Select the Local and Remote
Connections radio button to enable remote users to access this SQL Server instance. 
Click Apply.

5. An alert dialog will be displayed indicating that the changes will not take effect until the
Database  Engine service is stopped and restarted.  Click OK.

6. In the left pane, expand Database Engine and click on Service.  In the right pane, click
on Stop and then click on Start when that button becomes enabled.  Once the service is
restarted, click OK to exit the Surface Area Configuration tool.
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SQL Server 2008

1. Click on Start > All Programs > Microsoft SQL Server 2008 (2008 R2) > Configuration
Tools > SQL Server Configuration Manager.

2. Expand SQL Server Network Configuration and select the Protocols for InstanceName
that corresponds to the SQL Server instance that hosts the accounting system database.

3. Verify that the TCP/IP Protocol is "Enabled".  If it is not enabled, double-click on the
protocol and change its properties to enabled.  You will receive a warning that the
service will need to be stopped and restarted:
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4. Go to the SQL Server Services section.  Select the SQL Server service and click on the
restart the service button.
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5. In the SQL Server Services section, verify that the SQL Server Browser service is started. 
If it is not, double-click on the service to open the service properties.
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6. Click on the Service tab and make sure the Start Mode is set to "Automatic".
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7. On the Log On tab, click on the Start button to start the service
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Add Windows Firewall Exceptions

This step may not need to be performed if the Windows Firewall is turned off on the server.

Server 2003 (click here to go to the Server 2008 instructions)

1. Click on Start > Control Panel > Windows Firewall
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2. On the Exceptions tab, click the Add Port button.
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3. In the Add a Port dialog, enter a name for the exception entry and type "1433" for the
port number.  Click OK.

4. Add a second port exception for UDP 1434.
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5. Click the Add Program button then click the Browse button

6. Browse to the SQL Server installation’s Binn directory and select sqlservr.exe.
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7. Close the Firewall dialog after making these additions.

Server 2008

1. Click on Start > Administrative Tools > Windows Firewall with Advanced Security
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2. Click on Inbound Rules.

3. Click on New Rule.
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4. Choose the Port radio button and click Next.
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5. Leave the TCP option selected and type in port 1433.  Click Next.
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6. Leave the Allow the connection radio button selected and click Next.
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7. Uncheck the Public checkbox (unless users are connecting using a public network
location) and click Next.

8. Type a name and description for the exception and click Finish.



BizInsight 5.0.35.1 Applying Product Updates: Appendices

BizNet Software, Inc. 129| Page

9. Repeat these steps to add a UDP port exception for port 1434.
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10. Add a third new inbound rule for a program exception.
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11. Click on the Browse button and browse to the SQL Server installation’s Binn directory
and select sqlservr.exe.  Then click Next.
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12. Leave Allow the connection selected and click Next.
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13. Uncheck the Public checkbox (unless users are connecting using a public network) and
click Next.

14. Type a name and description for the exception and click Finish.
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Verify Reporting Services Data Source

The XMLFast feature cannot use data sources that are configured to use stored credentials.

1. Browse to the Reporting Services Report Manager URL. This URL will be very similar to
the Web Service URL but will use “Reports” instead of “ReportServer”. For example, if
your Report Server Web Service URL is http://BizNetSvr/ReportServer, your Report
Manager URL will be http://BizNetSvr/Reports.

2. Click on the Data Sources folder.

3. Click on the content pack data source.

4. Check to see if the Credentials stored security in the report server option is enabled as
shown below.
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If this option is not enabled, you can stop here.

5. Any data sources configured with stored credentials must either be changed to use
Windows Integrated Security or to prompt for SQL credentials.

Windows Integrated Security

1. To configure for Windows Integrated Security, check the Windows Integrated
Security radio button. Click the Apply button to save the changes.

2. Go to SQL Management Studio. Expand the Security section and confirm that
each BizInsight user's Windows login id has been added in SQL security and that
user has db_datareader rights to the accounting system database.

Prompt for SQL Credentials

1. To configure the data source to prompt the user for credentials, select the
Credentials supplied by the user running the report radio button.

2. Click Apply to save the change.

3. Go to each workstation where BizInsight is installed, click on the Application
Settings button on the BizInsight ribbon and check the Persist SQL Credentials
checkbox. Making this change will ensure that the credentials provided by the
user when prompted are stored in memory for the Excel session and they will
not be prompted each time a data retrieval call is made

 IMPORTANT  If your company has content packs for multiple accounting systems implemented
(ex. Sage 500 and CCH), you must check all content data sources to confirm none are con-
figured with stored credentials.
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Resolving “.xll could not be found” errors

In some rare instances, the name of the content add-in file provided with an update may
change. When an add-in file name is changed, Scan for Content will properly remove that add-
in file but will not delete the pointer to it that resides within Excel and the following error will
occur:

Perform the following steps to resolve the issue:

The remaining steps vary based on the Office version installed:

Office 2010/2013 steps
Excel 2007 steps
Excel 2003 steps

Excel 2010/2013

1. Click on File > Options.
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7. Click on Add-ins in the left pane and then click on Go at the bottom on the right
pane.
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2. In the Add-ins dialog, click on the Browse button.

3. Browse to the directory to which you installed BizInsight and select the .xll file in
that directory.  Then click OK.

The Add-ins dialog should now look like the following:
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4. Click OK.
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Excel 2007

1. Click on the Office button and then click on the Excel Options button.
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2. Click on Add-ins in the left pane and then click on Go at the bottom on the right
pane.
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3. In the Add-ins dialog, click on the Browse button.

4. Browse to the directory to which you installed BizInsight and select the .xll file in
that directory.  Then click OK.

The Add-ins dialog should now look like the following:
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5. Click OK.
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Excel 2003

1. Click on Tools > Add-Ins
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2. In the Add-ins dialog, click on the Browse button.

3. Browse to the directory to which you installed BizInsight and select the .xll file in
that directory.  Then click OK.

The Add-ins dialog should now look like the following:
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4. Click OK.

9. Once in the add-ins dialog, uncheck the add-in mentioned in the error message. You
should get the following message.  Click Yes.  If you do not get this message, you have
unchecked the wrong add-in.  Re-check it and uncheck the next one that is shown that
has a similar name.



BizInsight 5.0.35.1 Applying Product Updates: Appendices

BizNet Software, Inc. 148| Page

10. Close and reopen Excel to confirm that the error no longer occurs.



Assign rights in Reporting Services

This step probably has been addressed by the Content Installer Admin tool. In the event an error
occurred while users were being assigned security rights or you did not use the Admin Tool to
assign BizInsight security to the new user, follow these steps to assign them rights to the Report-
ing Services items.

NOTE  If you are managing Reporting Services security with an Active Directory group, make
sure the user is a member of that group and that group has been added to Reporting Services
security.

All BizInsight users must have rights granted to them in Reporting Services. Reporting Services
uses role-based security to secure access to items managed by the report server.

 IMPORTANT  Starting with the BizInsight build , the minimum pre-defined role necessary for a
BizInsight user is Content Manager. A script is provided in the document titled "Installing SQL
Server and Reporting Services" to create a custom role named “” that will assign only the min-
imum permissions required for the XMLFast feature.

Reporting Services Security is accessed by browsing to the Reporting Services Report Manager
URL (ex. http://servername/reports). Go to the Application Settings dialog of your currently
working BizInsight user and copy the Reporting Services URL that is listed in the dialog. Modify
the “reportserver” part of the URL to “reports” then paste into a browser.

 IMPORTANT  If Reporting Services is installed on a Windows Server 2008 or higher server and
User Account Control (“UAC”) is enabled, you must elevate your privileges when you start Inter-
net Explorer. To do this, press CTRL+Shift and then right-click on Reporting Services Con-
figuration Manager and select Run as administrator.

For SQL Server Reporting Services 2005 and 2008, go to the Properties tab:



For SQL Server Reporting Services 2008 R2, click on the Folder Settings button.

The following screenshot shows an example of a Reporting Service site with user security con-
figured. The user named “linda” has been given Content Manager permissions.



BizInsight Column Based Security Overview

Disclaimer:

The following information is for general purposes only. The information is provided by BizNet
Software and while we strive to keep the information up to date and accurate, we make no
representations or warranties of any kind, express or implied, about the accuracy or reliability
with respect to our internal research contained in this documentation. Any reliance you place
on such information is therefore strictly at your own risk.

In no event will BizNet Software, Inc. or BizNet Software, Inc. be liable for any loss or damage
including without limitation, indirect or consequential loss or damage, or any loss or damage
whatsoever arising from loss of data or profits arising out of, or in connection with, the use of
the documentation.

In any ERP system, the balance between making data accessible to end users while denying
access to those who should not have access is a difficult challenge. ERP security only at the
application layer is not a truly secured system; the communication between the application and
the data is exposed to users who are not authorized to access confidential information. BizNet
Software has incorporated four layers of security into the BizInsight product. These security
levels are as follows:

1. BizInsight License User Types Security

2. DataSet Security – applies to RDL security on the Report Server.

3. MetaData Security – applies to SQL Database and Shared Directory folder.

4. Column Security – applies to all functionality on content packs. (Functions, Drill-downs,
and Analysis Sets)

Of the above four security levels, two are specifically provided with the BizInsight product:
BizInsight License User Types Security and Column Security. The other two items, DataSet Secur-
ity and MetaData security, utilize the native security model provided with Reporting Services,
SQL Server,and Windows NTFS security.

BizInsight uses Reporting Services to store the queries and datasets used for connectivity to the
accounting system. Reporting Services provides its own security and BizInsight objects can be



independently secured using the delivered Reporting Services security model. Users must be
granted access to the BizInsight objects published to Reporting Services in order to utilize them.

BizInsight uses SQL databases (BizInsight and BizInsightDB) to store product metadata.
BizInsight users must be provided access to these databases using native SQL Server security. In
addition, the BizInsight shared directory is also a metadata repository and sufficient Windows
NTFS security.

BizInsight License User Types Security

This security level ensures that only licensed users are able to use the BizInsight product. In addi-
tion, BizInsight licensing is broken out into different user types: . The different user types have
decreasing capabilities with the Designer user having the most capabilities.

Column Security

Column security is based on a security policy that specifies the rules and conditions under which
a user can access a column value from a table. The column access restriction is based on indi-
vidual user permissions. When defining the column to apply the restriction, the column must
exist across all datasets from which BizInsight is retrieving data. In most business policies,
restricting access by the “Company" column is the most frequently used security logic; how-
ever, BizInsight provides the flexibility to utilize other columns.

The column security design uses an optimistic method in restricting user access: IT admin-
istrators will need to provide the values to deny. Values not listed are inferred to be allowed.
For example, if a user is permitted to access 97 out of 100 unique values, 3 restricted values
will need to be defined when defining column security for that user. The remaining 97 values
not defined in the security table will be able to be accessed by that user. All possible threats, vul-
nerabilities, and attacks and choosing the security design to implement are based on threat mit-
igation as first and performance second.

When column security is enabled and user restrictions are defined, access to the data will be
restricted for the particular user. On the client machine, the user restriction policy applies to all
content modules and functionality. Any access to functions, drill-down, and analysis set is
denied if the restricted value is inserted in the feature. In the scenario of multiple parameters
being passed to a function, if one of the parameter values is restricted, the security will deny
access completely even though the user many have access to the non-restricted values.



Security vs Performance

Design choices for securing a system affect performance, scalability and usability. The more
secure a system becomes, the more companies must compromise in terms of performance and
usability. In selecting the best balance between security and performance, the optimistic secur-
ity design has proven to be the ideal option. The below research and development results are
based on BizNet Software internal testing and illustrate the impact security has on per-
formance. Results will vary depending on network connection, environmental setup, and
Microsoft Office bitness.

Scenario:

Excel 2010 64-bit
BizData Iterations - 80,688
Dedicated Server and Client Machine

First Refresh
(sec)

Second
Refresh (sec)

Offline
Mode

Number of
Restricted
Values

Baseline: Security OFF on SQL Database 114.57 113.18 69.07 N/A

Security ON with no restricted users 111.4 109.38 75.18 0

Security ON and restricted values apply to
the current user

118.81 114.61 74.16 1

Security ON and restricted values apply to
the current user

124.54 119.9 80.14 6*

Security ON and restricted values apply to
the current user

132.14 126.58 86.39 12*

Security ON and restricted values apply to
other users

114.97 120.16 69.28 N/A

Security ON and restricted values apply to
all users

124.64 119.29 79.16 N/A

* Multiple restricted columns is not currently supported

Key Results:

1. When Security mode is activated with no restricted values in the security table, little to
no significant reporting performance loss.

2. When Security mode is activated with restricted values in the security table, there is
about a 10% loss in reporting performance.



3. When Security mode is activated with double the amount of restricted values in the
security table, there is about a double percentage loss in reporting performance.

Column Security Limitations

l Only a single column can be restricted. Multiple column security is not supported.

l The column must exist across all content packs.

l The column must exist as a server side parameter on RDLs. Security on optional parameters
is not supported.

l The column name should be uniform across all RDLs.

l Connected to an single ERP. Multiple ERP systems are not supported.

l Security is based on an ‘Exclusion Method’. IT administrators must insert values to restrict
access.

Requirements to Use Column Security

l BizInsight 5.0.35.0 and later is installed on all client machines.

l Existing BizInsight and BizInsightDB databases created using a Content Installer and were
created directly in SQL Server (not converted using the Access to SQL conversion tool).

l Reporting Services versions 2005*, 2008, 2008 R2, 2012 or 2014

 IMPORTANT  Reporting Services 2005 requires additional files to be installed. IT admin-
istrators must install the prerequisite files in a particular order. Following is a link to a
Microsoft article with links to the necessary download files.

http://www.microsoft.com/en-us/download/details.aspx?id=16978

http://www.microsoft.com/en-us/download/details.aspx?id=16978


a. Install Microsoft® System CLR Types for SQL Server® 2008 R2

The SQL Server System CLR Types package contains the components implementing
the geometry, geography, and hierarchy id types in SQL Server 2008 R2. This
component can be installed separately from the server to allow client applications
to use these types outside of the server.

b. Install Microsoft® SQL Server® 2008 R2 Shared Management Objects

The SQL Server Management Objects (SMO) is a .NET Framework object model that
enables software developers to create client-side applications to manage and
administer SQL Server objects and services. This object model will work with SQL
Server 2000, SQL Server 2005, SQL Server 2008 and SQL Server 2008 R2.

Column Security User Experience

When a user tries to access data to which they have been denied access, the cell will display
#VALUE.

To confirm that the error is due to Column Security, check the event log by clicking on the
About button on the BizInsight ribbon and then clicking on Support Tools > View Events. A
#COLUMN_SECURITY error will be logged there if the #VALUE is due to restricted access.

If the user refreshes a report that tries to retrieve data for a company to which they have no
access, an error message will be displayed indicating they have requested restricted data:



Analysis sets that try to retrieve restricted data will return #COLUMN_SECURITY:

Refer to the Installation Guide for instructions on implementing Column Based Security.
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